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1 Features 
 

 USB or PCI interface 

 Up to 2000Hz sampling rate 

 Data presentations and log to file capability 

 Full device configuration capability (Service mode access) 

 Temperature measurements 
 

 
2 System contents 
 

 STIM210 communication and power cable 

 Converter hardware:  
Alternative 1: USB/ RS422 interface cable, supporting 460800 bits/s STIM210 transmission bit rate 
Alternative 2: PCI/ RS422 interface card, supporting all available STIM210 transmission bit rates 

 Quick start manual (a hard copy of this document) 

 STIM210 evaluation kit PC software 

 CD-ROM/ memory stick with serial driver, kit installation files and documentation 
 

Notice: The evaluation kits does not include the STIM210 gyro module. 
 
 

3 System requirements 
 

 Minimum 2 free USB ports for the USB solution 

 Minimum 1 free USB port and 1 PCI slot for the PCI solution 

 Window Xp SP2 or later 
 
 
4 General descriptions 
 
The STIM210 evaluation kits provide measurement and configuration access to the STIM210 multi-axis gyro module. 
Device configuration, graphical result presentation, all data output units and save data to file are supported. The 
required single supply voltage (5VDC) for the module is provided from a communication and power cable connected to 
any PC or laptop USB port. 
 
Two alternative STIM210 evaluation kits are available, either for USB or PCI connectivity. 
 
 

 Alternative 1 – The USB kit: The evaluation kit with USB connectivity provides an easy setup for laptops or 
stationary PCs. A USB to RS422 cable and a STIM210 communication and power cable is included in this kit.  

 

 Alternative 2 – The PCI kit: The evaluation kit with PCI connectivity is the preferred solution for more thorough 
characterizing of the STIM210 gyro module. A PCI card and a STIM210 communication and power cable is 
included in this kit. 

 
 
  

 

  
Figure 1: Hardware options for STIM210 evaluation kits (USB cable or PCI card) 
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The STIM210 communication and power cable is exactly the same for the two kits. 
 

 
 

Figure 2: STIM210 communication and power cable 

 
 
The only difference between the USB kit and PCI kit is the interface, where the PCI interface provides the most robust 
solution. The USB interface supports 460800 bits/s, while the PCI card supports all available STIM210 transmission bit 
rates. 
 

 
 

Figure 3: Stationary PC with STIM210 EVK PCI card 

 
 
5 Configurable and readable parameters 
 
The STIM210 kits provide access to user configurable parameters:  
 

 Output format (angular rate, increment angle, etc.) 

 Datagram format (standard, extended, etc.) 

 Sampling rate (125 samples/s, 250 samples/s, etc.)  

 Bandwidth/ Low pass filter frequency (16Hz, 33Hz, etc.)  

 RS422 transmission bit rate (374400 bits/s, 460800 bits/s, etc.) 

 Number of stop bits in datagram (1 or 2 stop bits) 

 Parity bit (no parity, odd parity, even parity) 

 Line termination (on, off) 
 
 
The STIM210 kits provide access to user readable parameters, such as:  
 

 Full unit part number  

 Serial number 

 Firmware revision  

 Hardware revision  
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STIM210 diagnostic information is accessible, including RAM and flash checks, stack handling checks, status of 
internal voltage supply references, and various parameter reports for each of the measurement axes.  
 
Time of Validity (TOV) and external trigger functionality of STIM210 are not supported by these evaluation kits. 
 
 
6 Getting started 
 
6.1 Installation of NI serial cable assembly driver 
 
Before connection any hardware, install the National Instruments (NI) serial driver. The driver is found on the supplier 
CD-ROM (included). During installation the following windows appear: 
 

 
Figure 4: NI-Serial installation  
(1 of 12) 

 

 
Figure 5: NI-Serial installation  
(2 of 12) 

 
Figure 6: NI-Serial installation. Selections can be left as default 
(3 of 12) 

 

 
Figure 7: NI-Serial installation  
(4 of 12) 
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Figure 8: NI-Serial installation  
(5 of 12) 
 

 
Figure 9: NI-Serial installation  
(6 of 12) 

 
Figure 10: NI-Serial installation  
(7 of 12) 
 

 
Figure 11: NI-Serial installation  
(8 of 12) 

 
Figure 12: NI-Serial installation  
(9 of 12) 
 

 
Figure 13: NI-Serial installation  
(10 of 12) 
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Figure 14: NI-Serial installation  
(11 of 12) 

 
Figure 15: NI-Serial installation. Installation complete 
(12 of 12) 

 
 
6.2 Installation of PC software 
 
Follow this procedure to install the PC software. 
 

 Locate the software (a zip file) on the included kit CD-ROM/ memory stick, or download the latest PC software 
from the Sensonor support site (http://www.sensonor.com/help-menu/support.aspx). Unzip the zip package to 
a local drive, and run the installation file (setup.exe.) 

 Follow the instructions on the screen to complete the installation 
 

During installation the following windows appear: 
 

 
Figure 16: PC software installation (1 of 5) 

 

 
Figure 17: PC software installation (2 of 5) 

 

http://www.sensonor.com/help-menu/support.aspx
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Figure 18: PC software installation (3 of 5) 

 

 
Figure 19: PC software installation (4 of 5) 

 
Figure 20: PC software installation (5 of 5) 

 

 

 
 
6.3 First hardware connections 
 
Notice: The NI-Serial driver and PC software must be installed at this point. 
 
Connect system hardware as follows: 
 

 Connect a STIM210 module to the Micro-D connector of the STIM210 communication and power cable. A 
small Allen Wrench is needed for tightening the fixing screws of this connector to the STIM210 module 
connector 
 

 Connect the 9 pin D-SUB connector of the STIM210 communication and power cable to the NI RS422 
interface cable, or alternatively connect it to the PCI card (if this solution is used) 
 

 If the USB solution is used; Connect the NI RS422 interface cable into a free USB port of the stationary PC/ 
laptop (If the PCI interface card is used, this point can be skipped/ does not apply) 
 

 Verify that the device driver installation has completed successfully. The NI-Serial device should become 
visible in device manager (an example for STIM210 evaluation kit USB interface device recognition is shown 
in Figure 21). NOTICE: At this point; Remember or write down the COM-port number as this is needed later 
for editing the software parameter file of the PC software 
 



 

USER MANUAL EvaluationTool 
STIM210 Evaluation Kit 

 

DOK360 rev.0                                                                    8/16                                                              Sept 2011 
 

 
Figure 21: Showing the two port NI RS422 PCI card interface in device manager.  

A similar verification can be seen if using the USB interface 

 
 

 NOTE: Leave at this point the USB connector of the STIM210 communication and power cable for powering 
the device unconnected! 

 
 
6.4 First PC software start-up 
 
Notice: All hardware must now be connected, except for the USB connector for STIM210 power. 
 
For the first time start-up of PC software, follow this step-by-step list of instructions: 
 

 Navigate to the ‘STIM210 Evaluation Kit’ folder in the Windows start menu. The shortcut to start the STIM210 
Evaluation Kit PC software (“STIM210_EvalKit”) is found in this folder. Click to expand, and click to start the 
program 
 

 Directly after start-up of program a pop-up box appear and ask for a parameter file (an .INI-file). Select the INI-
file available in the installation folder 

 

 Verify that the software GUI (graphical user interface), Normal mode panel, is successfully shown. This is the 
panel shown by default. (Can be changed if required) 
 



 

USER MANUAL EvaluationTool 
STIM210 Evaluation Kit 

 

DOK360 rev.0                                                                    9/16                                                              Sept 2011 
 

 
Figure 22: STIM210 evaluation kit GUI directly after first start-up (Normal mode panel is shown) 

 

 In the parameters file (the INI-file), accessible from either menu or tab in software, verify that the Device-to-
COM port correlation is correct. Do this by checking the COM port assignment(s) in the parameters view 
versus the chosen device number (1 or 2) in the Normal mode panel Device selector. The password to enable 
edit contents of the INI-file from the parameters view is ‘stim’ 
 
Notice that the parameters view (actually the INI-file) can accept only already assigned port numbers (ref. 
device manager), OR alternatively 0’s for devices not in use, or else the connection later will fail (in the next 
step). There are 2 listed devices, since the PCI card is 2-port. 
 

 After completing the correct COM port configuration in the parameters view, press ‘OK’ in upper right corner of 
this tab to confirm parameters setting are OK and return back to the Normal mode by clicking directly on the 
Normal mode tab 
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Figure 23: An example for an already edited PC software parameters view (INI-file) 

 

 After having the correct COM-port assignment, establish the first connection to STIM210 by clicking the 
‘Connect to HW’ button. Verify that a green light appears in the Normal mode panel, and that the message 
‘Hardware connected OK’ is shown in the lower right corner of the panel 

 

 
Figure 24: Normal mode panel after first hardware connection. The green LED and 

the text in the lower right corner confirms hardware connection is OK 
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 Change the ’Apply voltage’ control switch position to ’ON’. A pop-up message telling to turn on power to 
STIM210 should appear. Proceed to turn on this power, 5V DC to STIM210, by inserting the not connected 
USB connector (of the STIM210 communication and power cable) into an available USB port of the PC. 
Confirm the supply voltage applied by clicking the ‘OK’ button on the following pop-up panel 
 

 
Figure 25: Normal mode panel when power is applied 

 

 The kit is now ready for use, and the connection and the module communication could be checked by e.g. 
pressing the ‘Request config DG’ button. An example of such result is shown below (in blue text in Figure 26) 

 

 
Figure 26: Result of sending ’Request config DG’ to STIM210 
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7 Introduction to different parts of PC software 
 
7.1 Panels overview 
In addition to the panel already shown (Normal mode and Parameters panel), some other panels are available in the 
PC software: 
 

 
Figure 27: Service mode panel 

 

 
Figure 28: Measure panel 
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Figure 29: Logging panel (for saving data to file) 

 
 
7.2 Main panel menus 
 

 ‘ParaFile’ → ‘Open’ : For taking a specific INI-file into use (e.g. the default “STIM210 evaluation.INI”) 

 ‘File’ → ‘New’ : For generating a new INI-file. Notice that this new INI-file should be edited before taken into 
use, and that it is not a copy of any existing INI-file 

 ‘ParaFile’ → ‘Save’: To save parameters into INI-file 

 ‘ParaFile’ → ‘Save as’ : For saving the current ‘Parameters’ content into a INI-file 

 ‘ParaFile’ → ‘Print’ : For printing the current ‘Parameters’ content at the default printer 

 ‘ParaFile’ → ‘Exit’ : To exit program 

 ‘Edit’ → ‘Parameters’ : To edit the ‘Parameters’ content 

 ‘Help’ → ‘About’ : About the program (software revision number etc.) 
 
 
7.3 Normal mode panel descriptions 
 
Table 1: Normal mode panel descriptions 

Panel unit Functionality and description 

Connect to HW To connect to interface hardware. Opens PC COM port according to selections in the 
parameter file 

LED Indicator for hardware connection. Lit GREEN when successfully connected 

Disconnect from HW To Disconnect from interface hardware. Closes PC COM port 

Apply voltage switch (On/Off) To be switched manually  (ON or OFF) by user when asked to. Controls certain 
functions of the PC software  

Device box Should hold the correct device number for the correct COM port number according to 
parameter file 

Reset device button Resets the device (the STIM210). Sends reset command (‘R’) 

Request config DG button Sends command (‘C’) to receive one configuration datagram 

Request identity DG button Sends command (‘N’) to receive one part number datagram 

Request serial# DG button Sends command (‘I’) to receive one serial number datagram 

Enter serv. mode button To enter Service mode 

Response window List the response to commands from the device (from STIM210) 
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Result file: 
 
The stored result file from saving from ‘Measure’ panel or from ‘Logging’ panel is placed in the folder as specified in 
the INI-file in use. Details for result file contents are shown in Table 2. 
 
Table 2: Result file contents descriptions 

Column label Description 

Time [s] This column holds time tag data for each row of measurement data listed 

GYRO_X X-axis data 

GYRO_Y Y-axis data 

GYRO_Z Z-axis data 

STS Status byte. Normally 0. See STIM210 datasheet, TS1545, for details 

RxCRC Re-calculated CRC on receiver side (in PC software) 

CalcCRC  Calculated CRC on transmitter side (in STIM210 micro controller) 

DG_ID Datagram ID. See STIM210 datasheet, TS1545, for details 

 
 
7.4 Service mode panel descriptions 
 
Service mode is used for device configuration. 
 
Service mode is entered by pressing ‘Enter serv. mode’ button in Normal mode. Panel units, functionality and 
description are listed in Table 3. Exit from Service mode is done by pressing either ‘Exit to Normal mode’.  
 
Notice: Changes applied by sending commands in Service mode are stored to flash memory of STIM210 by sending 
the save command (‘s’). 
 
Table 3: Service mode panel descriptions 

Panel unit Functionality and description 

Available commands window Shows a list of available commands. See STIM210 datasheet, TS1545, for details 

Complete command window Contains the complete command to send. It is auto-completed by usage of the 
listings in the available commands window. Left click in the complete command 
window shows a list of earlier sent commands. Right click enables manual command 
entry 

Send command button Sends command to device (STIM210) 

Command response window Shows the response to commands (the response from STIM210). See STIM210 
datasheet, TS1545, for details 

Erase button Erases the content of the command response window 

Save button Saves the content of the command response window to a text file with a detailed 
date and time tag 
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7.5 Measure panel descriptions 
 
Table 4: Measure panel descriptions 

Panel unit Functionality and description 

Measure button Starts a measurement series 

Samples box Defines the number of samples to be collected (max 50 millions) 

Save to file button Saves data from a completed measurement series to a result file 

X-, Y- and Z-axis check boxes Selects which axis data to present in the graph area (up to 3 axes can be plotted) 

CRC and DG-ID LEDS Confirms CRC and DG-ID as expected. LEDs turns red if checks fail 

Data box Selects which datagram content to be shown. Several options are available (use the 
arrows in the left side of box for selections) 

Sample rate box Informs what sample rate has been used for the measurements 

DG type Shows the type of datagram received 

Save to disk icon Saves a picture of the plotted data to file 

Print icon Prints a picture of the plotted data to the default printer 

1:1 icon Resets zoom level to 1:1 

Zoom icon Enables a custom zoom of the presented results in the strip chart (graph area) 
according to placement of available cursors 

Cursor 1 Shows the location of cursor no 1 

Cursor 2 Shows the location of cursor no 1 

Delta Shows the delta between the two cursor locations 

Progress bar A blue continuous line shows the measurement series progress 

Lower bar on panel Shows the INI-file in use and the active mode (NORMAL MODE) 

 
 
Save data to file feature: 
 
Measurement data can be logged to file from ‘Measure’ panel’ by clicking “Save to file” after a measurement series is 
completed. This result file contains several columns of tab separated data. An example of result file is shown in Figure 
30. A description of each column of data is found in Table 2. 
 

 
Figure 30: Result file example 
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7.6 Logging panel descriptions 
 
Table 5: Logging panel descriptions 

Panel unit Functionality and description 

Start button Start data logging 

Stop button Stops data logging 

Stop criteria slide User selections between “manually”, “no of samples” and “Time 
elapsed” for stopping a measurement series 

Samples box In use when defining a series with “no of samples” 

Time elapsed Shows the real time for the test running 

Samples acq. Shows number of samples collected 

CRC_errors Shows number of CRC errors (normally 0) 

Resynch’s Increments from 0 to a number if any re-synchronisations are needed in 
order to re-establish data collections from module 

 
 
7.7 Parameters panel descriptions 
 
Table 6: Parameters panel descriptions 

Panel unit Functionality and description 

===== General parameters =====  

Password Current valid password to be able to edit the parameters list. The 
password is “stim” by default. Can be changed 

Folder For Final Result File Storage “c:\\userdata\\test\\Final\\” by default.  Can be changed by user 

What Priority Will This Program Run With Instructs the program priority for the PC operation system 

What Format to Use For Result Files ASCII text by default, however can be changed to 8byte binary 

===== STIM communication =====  

RS422 port # to device # list Defining which device to be assigned to which COM port number 

RS422 Bitrate [bit/s] Manual RS422 bit rate selection. NOTE: The USB serial interface cable 
that comes with the USB kit supports only the 460800 bits/s option for 
STIM210, while e.g. the add-on PCI card supports all bit rates 

RS422 Stopbit 1 or 2. Default is “1” 

RS422 Parity None, odd or even. Default is “None” 

RS422 Input Buffer Size Recommended 1000000 (as default) 

RS422 Output Buffer Size Recommended 1000 (as default) 

===== External Hardware =====  

Unique ID of test equipment Normally NA 

The GPIB Card Number To Use Normally 0 (when no GPIB card in user). If card(s) are in use; the first 
card will be assigned to #1, second to #2, etc. Default value is “0” 

===== Powersupply =====  

Type Of Power Supply In Use Normally None (when not in use). Agilent E3631A, E3633A and E3644A 
supported. Default value is “None” 

Interface To Power Normally None (when not in use). RS232 (for Agilent E3631A only) and 
GPIB supported. Default is “GPIB” 

Port or Address to Power Selectable up to 31. Parameter should be neglected if not in use. 
Default value is “5” 

Voltage on Output Of Power Supply [V] Can be neglected if not in use. Should be within the supply voltage 
range of the device; however is never to exceed the absolute maximum 
ratings value! (7.0V) Default value is “5.1” 

Current Limit on Output of Power [A] To limit the current consumption from the power source. Default value is 
“1.0” 
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